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PIVOT TABLES AND CHARTS

CS1100 Pivot tables and charts



t’s difficult to see the bottom line in a flat list
ike this, turning the list into a Pivot Table will
nelp.

A B C D E F G
lan-07  Joseph North FastCar 3 1,592 563
Jan-07  Joseph Morth RapidZoo 8 1,088 357
Jan-07  Joseph West SuperGlue 8 1,680 753
Jan-07 Joseph West FastCar 9 2,133 923
Jan-07  Joseph West RapidZoo 10 1,610 579
lan-07  Joseph Middle SuperGlue 10 1,540 570
lan-07 Joseph Middle FastCar 7 1,316 423
Jan-07  Joseph Middle RapidZoo 7 1,799 709
Jan-07  Lawrence  Morth SuperGlue 8 1,624 621
lan-07 Lawrence  MNorth FastCar i} 726 236
lan-07 Lawrence  North RapidZoo 9 2,277 966
Jan-07 Lawrence  West SuperGlue 5] 714 221
Jan-07 Lawrence West FastCar 9 2,682 1,023
Jan-07 Lawrence West RapidZoo 6 1,500 634
Jan-07  Lawrence  Middle SuperGlue 7 917 403
lan-07 Lawrence  Middle FastCar 7 1,939 760
Jan-07  Lawrence  Middle RapidZoo 6 984 314
Jan-07  Maria MNorth SuperGlue 9 981 372
Jan-07 Maria Morth FastCar 10 1,520 476
Jan-07  Maria Morth RapidZoo ] 966 330
Jan-07 Maria West SuperGlue 10 2,800 903
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Pivot Tables

e So far we have been summarizing (filtering)
data using |IF statements.

* Pivot tables are a much more powerful,
“interactive” way to produce summaries.

— Can summarize information from selected fields of
a data source.

— Pivot: rows can easily become columns, columns
can easily become rows.



Examples

Summarizing data, i.e. finding average sales
for each region for each product

Filtering, sorting, summarizing data without
writing any formulas

Transposing data
Linking data sources



Organize your Data

 Must be raw data, unprocessed and
unsummarizec

e Each column should have a header.

e The data should have no blank rows or

columns
_Middle North West Grand Total

loseph 5 148,067.00 $ 139,014.00 5145,526.00 $ 432,607.00
vrence 5 141,498.00 5 151,3359.00 A 8 c D : ¢ G
5 142,013.00 $ 138,118.00
s 141,224.00 s 139,249.00 Jan-07 Joseph North FastCar 8 1,592 563
Jan-07  Joseph North RapidZoo 8 1,088 397
s 372,802.00 s 367,720.00 Jan-07  Joseph West SuperGlue 1,680 753
Jan-07 Joseph West FastCar 2,133 923
Jan-07  Joseph West RapidZoo 1,610 579
Jan-07 Joseph Middle Su 1,540 570
not raw d ata, Jan-07  Joseph Middle  FastCa 1,316 428
. Jan-07 Joseph Middle RapidZoo 7 1,799 709
alrea dy summarized Jan-07 lawrence North  SuperGlue 8 1,624 621
Jan-07 Lawrence North FastCar 6 726 236
Jan-07 Lawrence North RapidZoo 9 2,277 966
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Pivot Table Setup

* To create a pivot table, specify:
— Which fields you’re interested in
— How you want the table organized
— What kinds of calculations you want to perform

* YOou can:

— Rearrange it to view from alternative perspectives

e “pivot” the dimensions —i.e. transpose column
headings to row positions



Creating Pivot Tables

* Click on a cell from the table you want to
summarize.

From the Insert tab, click the PivotTable icon
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Creating Pivot Tables

e Select the range you want to summarize and
where you would like the pivot table to
appear.

* |tis helpful to name the range.
[ Create PivotTable )

Choose the data that you want to analyze

@ Select a table or range

Choose where you want the PivotTable report to be placed
@ New Worksheet
Existing Worksheet

Location: s




Creating a Pivot table

PivotTable Fields v X

 The PivotTable Field list is A
divided into sections.

* You can drag and drop the
fields you want in each area.  woenas.

* The body of the table will
contain three parts: Rows,
Columns and Cells. You can

use any fields in these areas.

Defer Layout Update



PivotTable Fields v X

Choose fields to add to report: 2

[] Month

[ ] Salesman
Region
Product

[ ] Mo. Customers
Met Sales

[] Profit / Loss

MORE TABLES...

Drag fields between areas below:

T FILTERS Il COLUMMS

| Region -
= ROWS Z VALUES
Product A | |A1.rerage of Me... ™

[] Defer Layout Update

CS1100
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Average of Net Sales Column Labels |E|

Row Labels '+ Middle North West Grand Total
FastCar g 1,582.69 % 1,651.58 % 1,621.86 & 1,618.71
RapidzZoo 3 1,570.33 $ 1,541.56 $ 1,571.69 $ 1,561.19
SuperGlue g 1,620.33 $ 1,550.78 S 1,588.04 & 1,586.48
Grand Total 5 1,591.12 5 1,581.39 $ 1,593.86 5 1,588.80

Northeastern University
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PivotTable Fields v X

Choose fields to add to report:

o~

[ ] Month
Salesman
Region
Product

[] Mo. Customers
Met Sales

[ ] Profit / Loss

MORE TABLES...

Drag fields between areas below:

Il COLUMNS
Order Matters! [[ymmes -
Rdws ¥ VALUES

| Sum of Met 5a... 7\ |

| Region - |
|

| Salesman -

[ | Defer Layout Update

CS1100

PIVOTTABLE TOOLS

ANALYZE  DESIGN /

Sum of Net Sales Column Labels |E|

You can add

subtotals, from the
Design Tab under
PivotTable Tools.

Row Labels |E| FastCar RapidZoo SuperGlue  Grand Total
= Middle
Joseph 5 48,180.00 5 49,898.00 S 148,067.00
Lawrence 5 49,858.00 5 45,937.00 S 141,498.00
Maria 5 50,023.00 5 48,855.00 S 142,013.00
Matt g 41,862.00 $ 49,750.00 § 141,224.00
iddle Total 5 189,923.00 $194,440.00 $ 572,802.00
= North
Joseph 5 48,185.00 S 46,434.00 S 44,335.00 S 139,014.00
Lawrence g 47,796.00 $ 52,030.00 $ 51,513.00 % 151,339.00
Maria 5 51,545.00 S 43,437.00 S 43,076.00 S 138,118.00
Matt g 50,664.00 % 42,966.00 $ 45,619.00 % 139,249.00
Morth Total 5 198,190.00 $184,987.00 $184,543.00 $ 567,720.00
="'West
Joseph 5 52,467.00 S 47,118.00 S 45,941.00 S 145,526.00
Lawrence g 44.870.00 $ 48,738.00 $ 44,046.00 % 137,654.00
Maria 5 46,676.00 S 43,636.00 S 49,111.00 S 139,423.00
Matt g 50,610.00 $ 49,111.00 % 51,467.00 % 151,188.00
est Total 5 194,623.00 $188,603.00 $190,565.00 $ 573,791.00
rand Total $  582,736.00 %562,020.00 $569,548.00 $1,714,313.00

Click the down
arrow to change
field settings and

formatting

Pivot tables and charts

11

Northeastern University
College of Computer and Information Science



Same data, different story

 The data is the same, only the perspective is

different

Average of Net Sales Column Labels | ~

Row Labels
FastCar
RapidZoo
SuperGlue
Grand Total

CS1100

Sum of Met Sales Column Labels ~

¢ of Co T

Row Labels - | FastCar RapidZoo SuperGlue  Grand Total
-IMiddle
Joseph S 43,180.00 $ 49,989.00 $ 49,898.00 S 148,067.00
Lawrence 5 49,858.00 $ 45,703.00 $ 45,937.00 S 141,498.00
Maria S 50,023.00 $ 43,135.00 $ 48,855.00 $ 142,013.00
Matt 5 41,862.00 $ 49,612.00 $ 49,750.00 $ 141,224.00
Middle Total $  189,023.00 $188,430.00 $194,440.00 $§ 572,802.00
Grand Total =/North
1,618.71 Joseph S 48,185.00 $ 46,494.00 $ 44,335.00 $ 139,014.00
1,561.19 Lawrence 5 47,796.00 $ 52,030.00 $ 51,513.00 S 151,339.00
1,586.48 Maria S 51,545.00 $ 43,497.00 $ 43,076.00 $ 138,118.00
=y Matt g 50,664.00 $ 42,966.00 $ 45,619.00 $ 139,249.00
North Total $  198,190.00 $184,987.00 $184,543.00 $§ 567,720.00
-'West
Joseph S 52,467.00 $ 47,118.00 $ 45,941.00 § 145,526.00
Lawrence 5 44,870.00 $ 48,738.00 $ 44,046.00 S 137,654.00
Maria S 46,676.00 $ 43,636.00 $ 49,111.00 § 139,423.00
Matt 5 50,610.00 $ 49,111.00 $ 51,467.00 $ 151,188.00
West Total $  194,623.00 $188,603.00 $190,565.00 $ 573,791.00
Grand Total $  582,736.00 $562,020.00 $569,5438.00 $1,714,313.00
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Add a Filter

Sum of Net Sales Column Labels ~

Row Labels | ~ FastCar RapidZoo SuperGlue  Grand Total Row Labels | ~ FastCar RapidZoo  SuperGlue Grand Total
- Middle - Middle
Joseph 5 43,180.00 $ 49,989.00 $ 439,898.00 5 148,067.00 Joseph S 1,316.00 5 2,079.00 5 1,434.00 5 4,829.00
Lawrence 5 49,858.00 $ 45,703.00 $ 45,937.00 5 141,493.00 Lawrence S 714.00 5 1,660.00 $ 1,296.00 $ 3,670.00
Maria 5 50,023.00 $ 43,135.00 $ 48,855.00 5 142,013.00 Maria S 1,666.00 S 1,611.00 5 1,575.00 5 4,852.00
Matt 5 41,862.00 5§ 49,612.00 5 49,750.00 S 141,224.00 Matt S 1,015.00 5 945.00 $§ 2,097.00 S 4,057.00
Middle Total $  189,023.00 $188,430.00 $194,440.00 §$ 572,802.00  Middle Total $ 4,711.00 $ 6,295.00 $ 6,402.00 $17,408.00
“INorth =INorth
Joseph g 48,185.00 § 46,494.00 S 44,335.00 $ 139,014.00 Joseph S 960.00 $ 1,125.00 $ 1,968.00 $ 4,053.00
Lawrence  §  47,796.00 $ 52,030.00 $ 51,513.00 & 151,339.00 Lawrence 5 2,930.00 $ 1,890.00 $ 1,490.00 $ 6,310.00
Maria $  51,545.00 $ 43,497.00 $ 43,076.00 $ 138,118.00 Maria $ 1,510.00 $ 1,656.00 $ 1,672.00 $ 4,838.00
Matt $  50,664.00 $ 42,966.00 $ 45,619.00 $ 139,249.00 Matt $ 2,628.00 $ 1,600.00 $ 1,584.00 $ 5,812.00
North Total S 19819000 $184,987.00 $184,543.00 § 56772000  MorthTotal § 8,028.00 $ 6,271.00 $ 6,714.00 $21,013.00
-'West -'West
Joseph $  52,467.00 $ 47,118.00 & 45941.00 $ 145,526.00 Joseph 5 2,088.00 5 1,020.00 $ 1,602.00 S 4,710.00
lawrence  $  44,870.00 $ 48,738.00 $ 44,046.00 $ 137,654.00 Lawrence 3 1,070.00 5 86100 S 2,080.00 S 4,012.00
Maria $  46,676.00 $ 43,636.00 $ 49,111.00 $ 129,423.00 Maria s 928.00 S 1,698.00 S 1,656.00 $ 4,282.00
Matt $  50,610.00 $ 49,111.00 $ 51,467.00 S 151,188.00 Matt 5 1,590.00 $ 2,660.00 $ 1,512.00 $ 5,762.00
West Total §  104,623.00 $188,603.00 $190,565.00 $ 573,791.00 | “vestTotal 5 5677.00 $ 6,239.00 $ 6,850.00 $18,766.00
Grand Total $  582,736.00 $562,020.00 $569,548.00 $1,714313.00  CrandTowl > 13,416.00 $13,805.00 $19,966.00 $57,187.00
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Working with Dates

e Often, there are many dates in a data set

* Excel lets us group data items together by day,
week, month, year...



Sum of Net Sales Column Labels |~
Jlan-07

Row Labels
= Joseph
FastCar
RapidZoo
SuperGlue
=lLawrence
FastCar
RapidZoo
SuperGlue
='Maria
FastCar
RapidZoo
SuperGlue
=l Matt
FastCar
RapidZoo
SuperGlue
IGrand Total

CS1100
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12,758.00
5,041.00
4,497.00
3,220.00

13,363.00
5,347.00
4,761.00
3,255.00

15,199.00
4,866.00
4,005.00
6,328.00

15,566.00
4,093.00
5,714.00
5,759.00

56,886.00

Working with Dates

Feb-07

$14,098.00
5 4,347.00
S 4,233.00
5 5,518.00
$13,384.00
5 6,124.00
S 3,147.00
5 4,113.00
$13,909.00
% 5,109.00
5 3,668.00
5 5,132.00
$16,492.00
5 6,087.00
5 4,959.00
5 5,447.00
$57,884.00

Mar-07

$12,692.00
5 4,376.00
S 4,193.00
5 4,123.00
$14,649.00
5 3,999.00
S 6,540.00
5 4,110.00
$12,733.00
5 4,410.00
S 3,585.00
5 4,738.00
$11,547.00
5 3,414.00
S 4,060.00
5 4,073.00
$51,621.00

Apr-07

£13,847.00
S 4,044.00
S 3,848.00
5 5,955.00
£17,050.00
5 5,332.00
S 6,994.00
S 4,724.00
£15,288.00
S 4,990.00
S 5,282.00
5 5,016.00
£13,596.00
5 5,185.00
S 4,006.00
S 4,405.00
£59,781.00

Pivot tables and charts

May-07

$17,063.00
S 3,143.00
S 6,488.00
S 7,432.00
$16,401.00
S 5,340.00
S 4,408.00
5 6,653.00
$14,182.00
S 6,007.00
S 3,447.00
S 4,728.00
$14,847.00
S 4,592.00
S 5,822.00
S 4,433.00
$62,493.00

Jun-07

$16,188.00
S 5,586.00
S 5,478.00
S 5,124.00
$15,969.00
S 3,774.00
S 5,170.00
S 7,025.00
$16,725.00
S 7,260.00
S 5,317.00
S 4,148.00
$13,475.00
S 4,993.00
S 4,789.00
S 3,683.00
$62,357.00
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Row Labels
=/Joseph
FastCar
RapidZoo
SuperGlue
= Lawrence
FastCar
RapidZoo
SuperGlue
=IMaria
FastCar
RapidZoo
SuperGlue
=IMatt
FastCar
RapidZoo
SuperGlue
Grand Total

CS1100

Working with Dates

Jan- ?I Feh-07
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12,758.0vEE  Lopy
5,041.01 Format Cells...

4,497.01 B Refresh

3,220.01
13,363.00 2o
5,347.00 Filter

4,761.00 Subtotal "Month"
3,235.00
Expand/Collapse

15,199.0:
48660008 _Group..)

4,005.00 B8 Ungroup..
6,328.00
15,566.01
4,093.01
5,714.01 |__'ﬂ. Field Settings...
5,759.01

26,880.00 | Hide Field List

Mowve

> Remove "Month”

Pivot tables and charts

PrvotTable Options...
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Row Labels
=/Joseph
FastCar
RapidZoo
SuperGlue
= Lawrence
FastCar
RapidZoo
SuperGlue
=IMaria
FastCar
RapidZoo
SuperGlue
=IMatt
FastCar
RapidZoo
SuperGlue
Grand Total

CS1100

Working with Dates

Jan- ?I Feh-07

B W e I e i L™ T s T o A W ¥ e i

12,758.0vEE  Lopy
5,041.01 Format Cells...

Mar-07

son Group sales by year

4,497.04 3 Refresh
3,220.01

13,363.08
5,347.00 Filter

4,761.00 Subtotal "Month"
3,235.00
Expand/Collapse »

15,199.0:
48660008 _Group..)

4,005.00 3§ Ungroup...
6,328.01
15,566.01

4,093.00
5,714.01 |__'ﬂ. Field Settings...

5,759.0i PivotTable Options...
20,886.00 ] | Hide Field List

Mowve *

> Remove "Month"

Pivot tables and charts

| By

[ Grouping (®Ir=]
) Auto
[¥f] starting at: | 1/1,2007
[¥] Ending at: | 6/2/2009
Seconds P
Minutes
Hours
Days
Fonths
guarters
Mumber of days: |1
[ oK ] [ Cancel ]
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Working with Dates

Sum of Net Sales Column Labels |~

Row Labels - | 2007 2008 2009 Grand Total

=l Joseph 5 174,220,00 $175,732.00 S 82,630.00 432,607.00
FastCar 5 56,0000 5 62,652.00 S 30,179.00 148,832.00
RapidZoo 5 80,766.00 5 57,395.00 5 25,440.00 143,601.00
SuperGlue 5 57,462.00 5 55,692.00 S 27,020.00 140,174.00

=l Lawrence 5 179,911.00 $165,670.00 S 284,910.00 430,491.00
FastCar 5 57,629.00 5 55,463.00 S 29,432.00 142.524.00
RapidZoo 5 80,734.00 5 56,766.00 5 28,971.00 146,471.00
SuperGlue 5 61,548.00 5 53,441.00 5 26,507.00 141.496.00

= Maria 5 172,488.00 $162,000.00 S 85,066.00 419,554.00
FastCar 5 61,752.00 5 58,400.00 5 28,092.00 148,244.00
RapidZoo 5 53,177.00 S 48,319.00 S 28,772.00 130,268.00
SuperGlue 5 57,559.00 5 55,281.00 S 28,202.00 141,042.00

= Matt 5 173,361.00 $168,200.00 S 90,010.00 431,661.00
FastCar 5 56,698.00 5 56,668.00 S 29,770.00 143,136.00
RapidZoo 5 56,738.00 S 56,119.00 S 28,832.00 141,689.00
SuperGlue 5 59,925.00 5 55,503.00 S 31,408.00 146,836.00

Grand Total 5 600,080,00 5671,600.00 5342,625.00 1,714,313.00

CS1100
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Slicers

* |tis not easy to see the current filtering state
when you filter on multiple items

 Slicers are easy-to-use filtering components with
buttons that enable you to quickly filter the data
in a PivotTable, without opening drop-down lists
to find the items that you want to filter.

* In addition to quick filtering, slicers also indicate
the current filtering state, which makes it easy to
understand what exactly is shown in a filtered
PivotTable report.



Slicers

 Slicers allow us to quickly filter the table to show
only the North region and the RapidZoo product for
all Salesmen

Salesman Region )4
Sum of Net Sales Column Labels -T ) n
Row Labels  -T RapidZoo Grand Total osep Middle
=INorth 5 184,987.00 $184,987.00 Lawrence North
Joseph 46,494.00 5 46,494.00 i
Maria West

5

Lawrence 5 52,030.00 S 52,030.00

Maria g 43,437.00 S 43,497.00 Matt
$
s

Matt 42,966.00 $ 42,966.00
Grand Total 184,987.00 $184,987.00
Product h#
FastCar
RapidZoo
SuperGlue
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Multiple Summary
Functions
PivotTable Fields % to the Same FIEld

Choose fields to add to report: -
Column Labels -
Month FastCar RapidZoo
vl Salesman Row Labels ~ Average of Net Sales Sum of Net Sales Average of Net Sales Sum of Net Sales

4

Region - Middle 5 1,582.69 $  189,923.00 $ 1,570.33 $  188,439.00
vl Product Joseph & 1,606.00 $  48,180.00 $ 1,666.30 $  49,989.00
Mo. Customers Lawrence $ 1,661.93 $  49,858.00 S 1,523.43 §  45,703.00

v Net Sales i
orofie Lo Maria g 1,667.43 $  50,023.00 S 1,437.83 §  43,135.00
' Matt 3 1,395.40 $  41,862.00 S 1,653.73 §  49,612.00
MORE TAELES... =North $ 1,651.58 $  198,190.00 $ 1,541.56 $  184,987.00
Joseph & 1,606.17 $  48,185.00 $ 1,549.80 $  46,494.00
Lawrence § 1,593.20 §  47,796.00 S 1,73433 $  52,030.00
Drag fields between areas below: Maria 3 1,71817 $  51,545.00 $ 1,44990 $  43,497.00
Matt g 1,688.80 $  50,664.00 S 1,43220 §  42,966.00
FILTERS COLUMNS -IWest $ 1,621.86 $ 194,623.00 $ 1,571.69 $  188,603.00
Product M Joseph & 1,74890 $  52,467.00 S 1,570.60 $  47,118.00
3 Values - Lawrence $ 1,495.67 $  44,870.00 S 1,624.60 $  48,738.00
Maria g 1,555.87 &  46,676.00 S 1,45453 §  43,636.00
ROWS Matt 3 1,687.00 $  50,610.00 $ 1,637.03 $  49,111.00
Region Y Average o e Grand Total  § 1,618.71 $  582,736.00 $ 1,561.19 $  562,029.00

Salesman - Surn of Met 5a...

\ Drag another copy of the field into the Values box.

Defer Layout Update

CS1100 Pivot tables and charts 21 T b
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Calculated Fields

In a pivot table, you can create a new field that
performs a calculation on the sum of other pivot

fields.

For example, we can create a calculated field
named Bonus to calculate 3% of the Total Net
Sales as a bonus for each salesperson.



Calculate a Bonus for each Salesperson

Row Labels | ~ Sum of Net Sales
Joseph | S 432,607.00 .I

Lawrence 3 430,491.00
Maria ¢ 419,554.00
Matt §  431,661.00
Grand Total $ 1,714,313.00 S — ]
- Row Labels ~ Sum of Net Sales S
. Add
Bame: | Bonus [] Joseph $  432,607.00 12,978.21
Formula: ='NetSaIes'*0.03|
Lawrence 5 430,451.00 12,914.73
Felds: Maria S 419,554.00 [ 12,586.62
;ﬂclmth R Matt 5 431,661.00 12,949.83
dlesman
Eeg‘;orgt Grand Total 4 1,714,313.00 51,429.39
rodu

Mo, Customers

Profit / Loss

Insert Field

CS1100 Pivot tables and charts 23 Northeastern University
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About Calculated Fields

For calculated fields, the individual amounts in
the other fields are summed, and then the
calculation is performed on the total amount.

Calculated field formulas cannot refer to the
Pivot table totals or subtotals

Calculated field formulas cannot refer to
worksheet cells by address or by name.

Sum is the only function available for a
calculated field.



To add a calculated field:

* Select a cell in the pivot table, and on the PIVOTTABLE TOOLS
Excel Ribbon, under the PivotTable Tools tab, ™ = anavze  oesian
click the Analyze tab. Emearv i
. . . i Select -
* Inthe Calculations group, click Fields, Items e
& Sets, and then click Calculated Field. Actions Calculations

(Calculated fields can also be modified here.)

* Type a hame for the calculated field, for example,
Bonus.

* In the Formula box, type in the formula

e Click Add to save the calculated field, and click Close.
The Bonus field appears in the Values area of the pivot
table, and in the field list in the PivotTable Field List.



Calculated Items

* Acalculated item is a new item in an existing field

* Derived from calculations performed on other items already in the field.

* Example: the service plan for FastCar adds 5% to sales for the product.
Create a new Calculated Item that calculates values for FastCar service
plans.

Row Labels ~* | Sum of Met Sales
= Middle $582,298.15
FastCar 5189,923.00
RapidZoo 5188,439.00
| superGlue | $194,440.00
adjustedFastcar 59,496.15
=/ North $577,620.50
FastCar $198,190.00 Insert Calculated Item in "Product” [ ? dF-J
RapidZoo 5184,987.00
SuperGlue $184,543.00)| | pyame =]
adjustedFastcar 59,909.50 Formula: | <FastCar *0.05
='West $583,522.15 =
FastCar $194,623.00 |
RapidzZoo $188,603.00 E'E'd’; T
Maon - FastCar P
SuperGlue 5190,565.00| | |zzlesman RapidZoo
adjustedFastear R [
1 adjustedFastcar
Grand Total $1,743,449.80 | | [N, Customers
Met Sales
Profit [ Loss
0K ] [ Close
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Calculated Items Warnings

A field with a calculated item cannot be moved to the
Report Filter area

Multiple copies of a field are not supported when a PT
has calculated items.

A problem can occur when a calculated item or
function defined in one pivot table is applied to other
pivot tables in an Excel file causing a conflict.

This can be solved by making pivot tables that are
based on the same source data independent.

— For instance, give the source data two different defined
names and use one of the names for a PT with a
calculated item and the other name for pivot tables
without.



Pivot Charts

You can also make charts of summarized pivot
table data. PIVOTTABLE TOOLS

AMNALYIE DESIGM

Clear - ['7 Fields, Ttems, 8 Sets -
Select~ fr OLAP Tools

II

PivotChart
Maove PivotTable O E Relationships

Mortinnc Talralatinne

Sum of Net Sales Column Labels |E|
Row Labels |E| FastCar RapidZoo SuperGlue  adjustedFastcar
Joseph 5 148,832.00 5143,601.00 5140,174.00 5 7441.60
Lawrence 5 142,524.00 5$146,471.00 5141,496.00 5 7,126.20
Maria 5 148,244.00 5130,268.00 5141,042.00 5 7412.20
Matt 5 143,136.00 5$141,689.00 S5146,836.00 5 7,156.80
sum of Met S5ales l
5160,000.00
5140,000.00 l
5120,000.00
Product =
5100,000.00 u FastCar
580,000.00 u RapidZoo
S60,000.00 ¥ SuperGlue
540,000.00 m adjustedFastcar
520,000.00
5-
Joseph Lawrence Maria Matt
€51100 a— 8 e e




Create a Pivot Table from an Access Table

From the Data Menu, choose “From Access”

HOME INSERT PAGE LAYOUT FORMULAS DATA

FIl E
E&i l [E DE)_ D Irg 2] Connections a|

Fram Frpm  From From Other Existing Refresh '_:J
Access Web Text Sources=  Connections All - -

Get External Data Connections
Select Table ? P

. . Mame Description  Modified Created Type
Find your Access file B OrderInfo 4/12/2012 8:08:51PM  4/12/2012 8:08:51PM  VIEW
Contacts 10/27/2010 9:45:31 AM  10/20/2008 9:57:08 AM  TABLE
and choose the table or [ Line Items 10/2/2010 3:11:44 PM 10/20/2008 10:19:37 AM  TABLE
query to use in your Orders 10/20/2008 10:39:43 AM  6/5/1994 12:58:54PM  TABLE
. Products 10/2/2010 3:12:24PM  &6/5/1994 12:58:58 PM  TABLE
P ivot table. ZipCodes 10/27/2010 9:45:46 &AM 10/20/2008 9:55:41AM  TABLE

K ] [ Cancel
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Any Questions?
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